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This program is free software; you can redistribute it and/or

modify it under the terms of the GNU General Public License

as published by the Free Software Foundation; either version 3

of the License, or (at your option) any later version.

1) Contribute by using the wiki at http://www.ap-i.net/ccdciel [http://www.ap-i.net/ccdciel]
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Tutorial

1- Connecting the equipment

When you run the program for the first time it know nothing about how you intend to connect your equipment and

which driver to use.

The first thing to do is to open the File→devices setup menu.

Make the choice to use INDI

  

or ASCOM drivers.

  

Create a new profile for your equipment.

All the devices and all the program options will be stored in this profile, allowing to have completely different

settings for your different equipments or locations.

Then indicate the list of devices to use. For example if you not have a motorized focuser be sure to uncheck

“Focuser”, otherwise the devices connection will failed.

For each device give the driver detail depending if you use INDI or ASCOM.

When ready click the OK button.

Select the left tab and locate the Connect button. The red dot indicate you are not connected to any device.

Click Connect, after a few seconds the light change to green with all the connected device listed below.
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If something go wrong one or more device color can change to orange when the program is still trying to connect or

red when an error is received.

You can look at the messages box for any indication about the error.

Next tutorial >>
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Tutorial

2- Global configuration

You access the global configuration from the menu Edit→Preferences.

There is a number of options for every part of the program and many can be examined later.

 

For now be sure to set a valid capture folder to save your images, and your observatory latitude and longitude that

are used for different function in the program.

Next tutorial >>
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Tutorial

3- Focusing

Point your telescope at the sky and set the Preview exposure time and binning, then click the Loop button.

Start with 10-15 seconds exposure time if you are way out of focus, move the focuser to reduce the size of the star

disk, and when they are small enough change the exposure time to about 1 second.

Let the preview in loop and click the Focus tab to show the focuser and star profile

Double click on a star, check it is not saturated, and check “Manual focus aid” to magnify the star image.

You can now use the focuser buttons, or manually turn the knob to make the star as small and bright as possible.

When ready uncheck “Manual focus aid”.

Let Auto-focusing disable for now as this require more configuration.

Next tutorial >>
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Tutorial

4- Simple capture

Open the Capture tab and set the required options:

The exposure time

The binning

The name of the object

The number of exposure to take

Be sure the type is Light, other setting may let the shutter closed!

You can also choose to dither between exposure and to regularly adjust the auto-focus.

If you have a filters wheel also set the filter to use.

You can set the frame if you not want to use the full surface of the sensor

And if you can control the CCD temperature enter the desired value in Setpoint, and click the Set button.

When all is ready click the Capture Start button.

The telescope box show you the current position, the park and tracking status and the remaining time to reach the

meridian.

The status bar show the sequence number of the image in progress and the remaining exposure time

After the exposure is terminated the image is show in the screen and the file saved according to your settings. A

message in the status bar indicate the last saved file 

And it continue for the number of exposure you set.

You can then change the filter and start the next series. Or look at the next tutorial how you can automate that…

Next tutorial >>
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Tutorial

5- Automated sequence

The Sequence tab allow you to automate a full night of observation.

The example on the right will first go to M13 for a four hours image, consisting of 24 luminance, 8 red, 8 blue and 8

green exposures of 300 seconds each.

Then it go to M92 and do the same.

Finally a script park the telescope at the end of the night.

To take full advantage of this automation you need to configure:

the astrometry resolver for plate solving and the slewing options

the focuser and autofocus options and calibration

the autoguider connection and preferences

the planetarium connection to help to set the object coordinates

the automated meridian flip options

And most important you must be sure your telescope mount and all the equipment include a way to

protect themselves against an unwanted operation. This include hardware slew and tracking limit on the

mount.

You can read more on how to edit a sequence in the specific sequence page.
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File Menu

The File menu includes the following options:

Devices Setup

Bad pixel map

Open FITS file

Save FITS file

Open reference image

Clear reference image

Quit
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Device setup

Open this window from the menu File → Device setup before to connect to any devices.

Interface

 

The first tab “Interface” let you select the kind of drivers you want to use, INDI or ASCOM if running on Windows.

Create a new profile for your equipment.

All the devices and all the program options will be stored in this profile, allowing to have completely different

settings for your different equipments or locations.

For INDI you have to enter the network name or IP address, and the port of the INDI server, then click the button

“Connect and get devices list” to make the program know which devices are available.

For ASCOM there is no additional information.

Note that the program will close and restart if you change between INDI and ASCOM.

Devices

In the tab “Devices” you must check the devices you want to connect to CCDciel.

Only the camera is required to run the program but any other device checked here must be present to allow the

program to work.

Camera
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Select the camera to use with CCDciel, from the dropdown list for INDI or using the ASCOM chooser.

For INDI the “sensor” field is to select the sensor to use for dual-chip camera, you probably always want “Main

sensor” here.

Check the corresponding box if you want to automatically load the INDI saved configuration when the device is

connected.

Filter wheel

 

Select the filter wheel to use with CCDciel, from the dropdown list for INDI or using the ASCOM chooser.

Or check the corresponding box if the filter wheel is commanded by the camera driver.

Focuser

 

Select the focuser to use with CCDciel, from the dropdown list for INDI or using the ASCOM chooser.

Or check the corresponding box if the focuser is commanded by the mount driver.

Mount
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Select the telescope mount to use with CCDciel, from the dropdown list for INDI or using the ASCOM chooser.

Click OK after you finish your setting.
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Bad pixel map

The bad pixel map prevent the auto-focus or slewing function to lock on a bad pixel.

It is only use for the preview images, when running a focus or slewing function, the capture image are never

processed for bad pixel.

You first need to configure the bad pixel detection threshold in the preview options.

. 

Increase this value if you get too much bad pixels, there is a limit to 1000 and you get an error message if you reach

it.

Decrease the value if you get too few, specifically if you use a low dynamic range camera.

Next set the Preview tool, use the same binning as for the focus and slewing, and set the exposure time to get a dark

with enough visible bad pixels. Depending on your camera this can be from 10 to 60 seconds.

Cover the camera or telescope as to take a dark image. If your camera as a shutter it will remain closed during the

exposure.

Then select the menu File / Bad pixel map / Create bad pixel map

Click Continue.

It take the dark and show the number of bad pixels in the log window.

Now take a preview image and check the bright bad pixels are removed.

If you no more want to use the bad pixel map select the menu File / Bad pixel map / Clear bad pixel map
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Open FITS file

From the menu File → Open FITS file.

This let you load a FITS file in the preview window instead of taking the image with the camera.

This is useful if you want to review a previous shot from the capture sequence, or to play with some other image.

But note this is not a general FITS file viewer, it is intended to display the images from a camera but it will fail to

open a FITS file with complex data.
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Save FITS file

From the menu File → Save FITS file.

This let you save to a FITS file the image in the preview window.

This is not used part of the capture sequence as the files are automatically saved, but this can be useful to save an

image taken with the Preview function or loaded with File → Open FITS file.

Be careful this Preview image can be processed for bad pixel if you create a bad pixel map.
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Reference image

You can load a reference image of the object you want to capture to adjust the position of the telescope and the

rotation of the camera. This is very useful to continue a sequence over many night.

You can adjust the display threshold and the color of the reference image in the preview options. 

Normally you want the threshold to display only the stars from the reference image.

To load the image use the menu File / Open reference image

Then start a preview loop, it show the new image over the reference.

You can now move the telescope or rotate the camera to match the reference.

When you are satisfied with the result you can remove the reference image from the menu File / Clear reference

image

Tips:

To help to center the telescope open first the reference image with File / Open FITS file. Right click on the image

and select “Resolve and slew to image center”. After the telescope stop slewing process as above to adjust the

rotation.
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Quit

From the menu File → Quit.

Exit the program and save the configuration.

If the devices are connected you are asked if you want to disconnect them.
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Edit Menu

The Edit menu consists of the following items:

Preferences

INDI settings

View FITS header
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Preferences

From the menu Edit → Preferences.

Set global preferences and options for the program.

Files

Set Files options to select how your images sequences will be saved.

Give first the base capture folder to use.

Then select how to make subfolder based on sequence name, frame type, object name or plan step, exposure time,

binning.

Then how to name the files based the object name, the filter, a date sequence, exposure time, binning.

The last checkbox is to saveall the message log to a file for further inspection or debugging.

Informations

This Informations will be set in each FITS file for the OBSERVER, ORIGIN and TELESCOP keyword.

The latitude and longitude of the observatory is used to get the Alt/Az position of the object, or for the

scope_alignment script.

Preview
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This settings affect only the preview, the FITS files are recorded in RAW format to allow further preprocessing.

If you use a color camera you can debayer the preview image by checking the corresponding box and selecting the

color pattern for your sensor. If you don't know what to select, make a test on a colorful subject on daytime. You can

also do some color balance with the cursors on the right.

Select the threshold and color for the display of the reference image.

Select the threshold for detection of bad pixels for the bad pixel map.

Select the preview rate for the video. Video require a suitable camera and is available only with INDI devices.

CCD temperature

Configure how you prefer to cool down and warm up you CCD sensor.

Consult your camera documentation to know if you need to limit the temperature change. 

In this case check “Limit temperature change” and indicate the maximum rate in degree (Celsius) per minute.

Check the corresponding box if you want your camera to start cooling as soon it is connect to the program and

indicate the target temperature you want.

Focus
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Select the size in pixel of the star detection area and the size of the zoomed window for the focus mode.

For each filter you can also set a focuser offset in focuser steps that will be applied to the focuser when you change

the filter.

The filter exposure factor is used for the auto-focus functions. For example if your R filter require two time the

exposure of the L filter set : L=1 R=2

Auto-Focus

Select the method to use for auto-focus:

V curve: This is the preferred method for absolute position focuser. You do a one time V curve learning

procedure and then every auto focus operation is done quickly in a single step starting from any position.

Dynamic: This method can be used with relative position focuser. It require you start very near of the focus

position and it make a small V curve every time.

Iterative: A dumb method that move in one direction or another as long the star diameter is smaller. I as the

advantage to work with any kind of focuser and you can start with a very defocused star. But it is slow and

imprecise.

None: If you want to use your focuser only manually.

Common parameters

Exposure time to use for the auto-focus operation. This time is multiplied by the filter exposure factor above.

Binning to use for the auto-focus. Use binning 1×1 unless you are way oversampled.

The move direction of the focuser. Depending on you setting the focuser can work better when moved in or out

of focus.

The maximum HFD that can be considered as a successful focus. Be careful to not set too low or a sequence at

low altitude can be canceled for that.

V curve parameters

Near focus HFD: We move the focuser to get this HFD to make the measurement on the V curve. This is not the

focus HFD, it must be half way on the linear part of the curve. For example if your focus HFD is 3.0 and you

make a V curve up to a HFD of 20.0, you can set 10.0 here.
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n.exp : The number of exposure we take to get a mean HFD value. Increase this value if the seeing is not good.

Dynamic parameters

Number of dynamic points: The number of points we take on the curve. Do not set too high as this is done at

every focus operation.

Movement between points: The number of focuser steps we move between each measurement of the curve.

The maximum focuser movement in and out of current position will be (Number of dynamic points)*(Movement

between points)/2

Iterative parameters

Near focus HFD: the HFD we start to use n.exp exposure to get a mean HFD. When the HFD is higher that this

we take a single exposure to speed the process.

Initial movement in focuser steps. This is the movement we use between measurement on the first iteration. It

is then divided by two every time we change the direction.

Final movement in focuser steps. When we reach this movement value we consider we are at the focus. This is

typically the focus tolerance of your optical system.

Astrometry

 

Enter the camera pixel size and telescope focal length, or if applicable for your driver, check the box to get it

automatically.

You can also adjust the timeout (in seconds) for a solve operation.

Select the software you want to use for the astrometry resolution of the images, you can use astrometry.net

[http://astrometry.net/use.html] or Elbrus star locator [http://www.astrosurf.com/pulgar/elbrus/elbrusin.htm]

For each software you can adjust a few option to make them work quickly and reliably with your images.

Astrometry.net options

Minimum search radius: Is a tolerance in degrees to the telescope position. Set this value high enough if you

use the plate solving to make a pointing model.

Scale tolerance: The tolerance on the pixel scale derived from the focal length and pixel size.

Downsample: the image by this factor. Use at least 4 or 8 for DSLR images. For CCD it is better to use binning.

Maximum number of source to consider.

Create plot of the result: create png image with indication useful for debugging.

Other options: any other option you want to give to the solve-field command.

Use custom script: Use a script instead of the solve-field command. There is two example with the program,

one for remote execution using ssh, the other for remote solving with the astrometry.net python script.

On Windows only, you need to specify the Cygwin path to where astrometry.net is installed, for example

C:\cygwin. See the installation instruction for more details.

Elbrus options

Elbrus images folder: the folder where Elbrus wait for new images to solve.

Images folder Unix path: Unix only, the unix path corresponding to the previous one where CCDciel save the

image for measurement.

Slew
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You can adjust how to correct the mount position after plate solving a control picture. 

If your mount allow to sync anywhere select “Mount sync”, if not select “Pointing offset” to make the correction in

software.

Use “Pointing offset” with EQMOD to not fool the pointing model.

Then set the precision you want/can reach and the maximum number of pointing/correction retry before to give up.

Set the parameters (exposure time, binning and filter) for the control exposure. This must give enough stars with

your telescope/camera combination for the astrometry resolver to work.

Meridian

Configure here what you want to do when the mount reach the meridian.

Do nothing: select this option if your mount is not affected by the meridian (fork mount).

Automatic flip: automatically do a reversal of the mount to continue to track past meridian.

Abort: abort the current capture and stop the mount.

Automatic flip options

Can track past meridian for: the number of minute your mount can safely track past the meridian without

flip. This depend on the declination, set the smaller value here.

No flip until past meridian for: the minimum number of minute after the meridian we wait before to initiate

the flip. This two parameters allow to loss the minimal time during a capture sequence, otherwise you can wait

for a long as a single exposure time.

Autofocus after meridian flip: In some case the focus point can move after a flip.

Calibrate autoguider after meridian flip: If your mount do not report the side of pier to the autoguider you

must check this option.

Pause before meridian flip:

Pause after meridian flip: this two checkbox give you a prompt before or after the flip to let you the time to

do some manual operation on the mount (moving the counterweight for example).

Timeout: The maximum time we wait for the after meridian pause, if you not close the prompt after this time

the sequence continue automatically.
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Autoguider

Select your autoguiding software, only PHD2 is available at the moment.

Set the network name of the computer running PHD2 and the port number.

Set the options for dithering between the exposure, the number of pixel (in the guide camera) and if you want to

dither only in RA (if you have a lot of DEC backlash).

The settle tolerance define how we consider the autoguiding as good after a dither operation or after it start.

It must stay within the number of pixel for Min.time. But we wait for the maximum of Timeout if this is not possible.

Set also the maximum time to wait if a new calibration is required.

In the case of guide star lost (passing clouds…) we can try to restart the guider after some time. This is useful if the

star as moved out of the search area, but if the clouds are still there we can start guiding on a hot pixel. A value of

zero disable this function.

Then we can abort the current sequence after some time, maybe the next object on the plan is in a clear area.

Planetarium

Select the planetarium application you want to use.

You have the choice between Skychart  [http://www.ap-i.net/skychart] on local or remote computer.

Or a SAMP [http://www.ivoa.net/samp/] application like Aladin [http://aladin.u-strasbg.fr/aladin.gml] or Topcat

[http://www.star.bris.ac.uk/~mbt/topcat/].
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INDI settings

From the menu Edit → INDI settings.

This menu is not active if you select the ASCOM devices interface.

This open a standard INDI client  [http://www.indilib.org/] window where you can set any specific option for your devices.
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View FITS header

From the menu Edit → View header.

Show the FITS header of the current file.
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Tools Menu

The Tools menu let you select the tools you want to include or not in your screen.

Check or uncheck each tool to make it visible or not.

You can also move each tool on another part of the screen to suite your need just by dragging the tool title to one of

the main window border.

It includes the following options:

Connection

Preview

Autoguider

Planetarium

Script

Focuser

Star profile

Capture

Filters

Frame

CCD Temperature

Telescope mount

Sequence

Video

Visualisation

Messages

Reset to default

By default many tools are grouped in four tabs on the right of the window.

This correspond to the main functionality for a capture session.

Connection and preview

Focusing

Simple capture

Automated sequence

You can use the keyboard F1 to F4 to select one of the tabs.

This same function are also available from the main menu:
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Connection Tool

This tool let you connect or disconnect your equipment and monitor the status.

It is a mandatory tool as the first thing to do after starting the program is to click the Connect button.
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Preview Tool

This tool is to take a preview exposure for focusing or centering purpose.

Set the exposure time and the binning to use for the preview. This setting is totally independent of the Capture

setting.

Click Preview for a single exposure or Loop to take exposure continuously until you stop it with the same button.
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Autoguider Tool

This tool is to interface with the external autoguider.

Start the autoguider application and then click the Connect button.

It show the autoguider status and let you to start or stop autoguiding, force a new calibration, or dither.

This functions are used automatically by the sequence tool when the autoguider is connected.
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Planetarium Tool

This tool is to control the connection to the planetarium.

It is used to display an astrometry resolved image with the right click menu, or to set the targets coordinates in the

sequence preparation.

Click the New target button, click or search an object in the planetarium.

This make a plate solved slew to the object position and set the object name in the Capture tool.
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Script

This tool let you create or run a script

The scripts can be used to automate some task in CCDciel or to interface with external program for example to

manage your observatory and equipment.

The same scripts can be used as a step in a sequence, or in specific conditions, but this box is a convenient way to

create, test and quickly run any script.
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Focuser Tool

Use this tool to move your motorized focuser.

The tool use different control depending if your focuser use absolute or relative position.

V curve learning

If you use an absolute position focuser and you select to use V curve auto-focus you see a V button on the right, this

is to learn the V curve.

Before you click this button you must center and select a bright star, set the Luminance filter, start a preview with a

one second exposure time, run the manual focus aid and check in the Star profile tool the peak intensity is about

80% of your camera saturation.

The first time you launch this tool all the settings and graphic are empty.

Indicate the most accurate focus position you can estimate, as you make a manual focus just before you can click the

Get current button here.

Set the Max offset value so that moving to the best focus position plus this offset give a defocused image with an

HFD around 20.

Set the number of step to 30, this is a good value that allow for precision curve. But for the first try you can save

some time by setting it to 10. Just remember to repeat with 30 when you are accustomed with the procedure.

When this three numbers are set click the Learn button on the bottom.

This window is not refreshed until the procedure is finished. But you can follow the progress in the Log and Star

profile tools.

After all the measurement are done it display the curve as in the screen shot here. The graph show the HFD value in

function of the focuser position.

There is some important check to do before to go further.

The curve must be centered with top left and right about at the same level.

It must extent to about the double of the value of Near focus HFD in the options, indicated by a blue line here.
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The two branches of the V must show a long linear part, specifically on the side of the base of the focus

direction arrow (right on the screen shot).

The branches must not flatten on the top. If you remark such behavior you must reduce the Max offset value.

You remark a flat or curved part at the center of the V with the points marked in red. 

It is important to exclude this points from the linear regression and you can use the Fit cursor to exclude more or

less points.

When you adjust this cursor, look to maximize the Quality value on the right but also check the aspect of the black

regression line across the green circles. The linearity must be specially good at the intersection with the blue line.

When you are satisfied by the result click the Save button.

You can now try the Autofocus in the Star profile tool.
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Star profile Tool

This tool is to control the focus by examination of a star image. It can be used with a manual or motorized focuser.

Take first a preview exposure and double click on a non saturated star.

The top drawing is a cross-section of the star image, try to make it as narrow as possible.

Below is the relative value of the previous measurement of HFD in red and intensity in green.

The Half Flux Diameter value is show in pixel.

The Full Width at Half Maximum is show in pixel and arc-second.

Make this two values as small as possible.

Also check the peak intensity of the star. It is very important it is not saturated.

Check “Focus aid” to start a preview loop on a zoomed area around the currently selected star.

Check “Autofocus” to start the auto-focus procedure on the selected star. You must have previously configured the

auto-focus method and parameters, and eventually learned a V curve.
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Capture Tool

This tool is to take a simple sequence of exposure.

Set the exposure time and binning you want.

Give an object name, it is used for the file name and the OBJECT keyword in the FITS header.

Set the number of consecutive exposure to take.

Select the type of frame: Light for sky exposure. Bias, Dark, Flat for the calibration.

This is used for the folder name and the IMAGETYP keyword in the FITS header. If your camera as a shutter it will be

closed for Bias and Dark.

Check if you want to dither every given number of exposure. This require the autoguider is connected, configured

and guiding from the Autoguider tool before you start the capture.

Check if you want to auto-focus every given number of exposure. You must have previously configured the auto-

focus method and parameters, and eventually learned a V curve.

The telescope move to a star of the configured magnitude to run the auto-focus. To allow to return precisely on

your object you must have configured the plate solver and the slewing options.

Click the Start button to begin the exposure. The same button can be used to interrupt the sequence.
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Filter Tool

This tool is to control your filter wheel.

It show the currently mounted filter.

To change the filter, select a new one in the list.
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Frame Tool

This tool is to view or set the area of the sensor used for imaging.

The first row is the horizontal starting point and width.

The second row is the vertical starting point and height.

You can set the values with the mouse on a preview exposure. Press the Shift key and the mouse left button to draw

the frame.

Click the Set button to send the values to the camera.

Click the Reset button to reset to full frame.
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CCD Temperature Tool

This tool is to control your CCD temperature.

It show the current CCD temperature and the consign set point.

Change the consign and click the Set button to start the cooler. 

If you configured a maximum temperature rate the button text change to “Cancel” to let you cancel the current

temperature change.

You can also control the cooler with the checkbox.
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Telescope Tool

This tool display the current telescope RA/DEC position, the side of pier if reported by the driver, the time to or from

the meridian.

You can park or unpark the mount using the corresponding button.

The Track button start the mount tracking.

Use the planetarium or the sequence tool if you want to move the telescope at a new location from CCDciel.
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Sequence Tool

This tool is to control a complex sequence of exposure on one or more objects.

The top grid show the current list of targets.

You can Load an existing file with a list of target, create a New one, Edit the current list, Copy to a new list or Delete

a list.

Use the Start and Stop button to start or interrupt a sequence.

The “Run unattended” check box control how the program react in case of error.

If is not checked a message prompt you on the screen what you want to do.

If it is checked the operation is canceled.

The bottom grid show you the plan for the current target.

When the sequence is running the current target and step is highlighted.

Target editor
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After you click New or Edit, the target editor let you modify the target list.

A target can be an object you want to take the images or a script to run in the sequence.

You can type the object name and coordinates in the corresponding box or click the Planetarium button to select the

object in the connected planetarium application. Or click the “No move” button to not change the telescope position.

Select the exposure plan to apply to this target using the dropdown box, or use the New button to create a new plan,

or the Edit button to change the plan. You can also copy an existing plan or delete one.

Check the corresponding box to refine the telescope position with an astromery solved control exposure. In this case

you are ensured the selected object is framed exactly as you want.

You can repeat the same target after a delay. Set the number of repetition and the delay. You can also start a

preview loop while waiting for the next repetition.

You can also repeat the whole list a number of time by checking the box at the bottom of the list. 

To add a script you just have to select the one you want from the list, or create a new script here. 

You can add a new target or script or delete one with the three buttons at the bottom of the list.

You can change the target order with a mouse drag/drop on the first column of the list.

The target list is saved when you click the Close button. If this is a new one you are asked for a file name.

Plan editor

Use the plan editor to specify the exposure steps to take of a target.
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Give a description of the step that can be used to make a subfolder.

Set the type of frame, exposure time, binning, number of exposure, as in the Capture tool.

Set the filter to use as in the Filters tool.

Check corresponding box if you want to run an auto-focus at the start of this step. 

For long steps you can also repeat the auto-focus after a given number of images.

You can repeat the same step after a delay. Set the number of repetition and the delay.

You can add a new step or delete one with the two button at the bottom of the list.

You can change the steps order with a mouse drag/drop on the first column of the list.

The plan is saved when you click the Close button.
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Video tool

This tool is only available for INDI camera, specifically on Linux and Mac. 

See this tool as a proof of concept, for serious planetary work you are encouraged to use the much better softwares

that already exists on every platform.

The video tool appear in a new tab after the Sequence if the INDI camera you connected as video stream capability.

You must first set the preview rate in the Preview options. Do not use a too high value as this preview frames have to

transit by the network.

Check Preview to visualize the frames.

Select the exposure range in the drop down box then adjust with the cursor.

Depending on the camera there can be other settings for the Gain, Gamma or Brightness.

The More settings button open the INDI client for this camera, this let you to access some properties specific to

your camera.

Two more drop down list are to select the image size and the frame rate.

Next are the video capture options, you can limit the capture time or the number of frames.

The object name is use for the filename the same way as the static images.

Click the Start to start recording. The recording to the video file is alway directly done by the INDI driver without

any action from CCDciel.

Use the Stop button if you want the stop the recording before the planned end.
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Visualisation Tool

This tool is to control the aspect of the preview image. None of the setting here have any influence to the image

saved as a FITS file. They are only to help you to view the most of detail on the single raw images.

It is separated in two part, an histogram of the image and the control buttons.

On the histogram you can move the high (green) and low (red) clipping bar with the mouse.

On the top row, the first three buttons are to control the range of histogram drawing, using 99.5%, 99.8% or the full

histogram range.

The three left button let you select a linear, logarithmic or square root scale to display the image.

The four right button are preselected zoom level for the image.

When the zoomed image is bigger than the screen you can move it with the left mouse button.

The bull eye button show the mark on the image.
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Message Tool

This tool display the message log from the program or from the different drivers.
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Help

Some help to use the software.

PDF documentation open the PDF documentation installed with the software

Online documentation open the documentation in a web browser

Report a problem open the CCDciel bug tracker

Download latest version open the SourceForge download page. Ignore this entry if you use a package from

your Linux distribution.

About show the program version and copyright notice.
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Right click menu

Right click on the preview image to show the following menu:

Plate solving functions

If you use more than one of this functions on the same image, only the first used function call the resolver, the other

use the astrometry saved in the file.

Resolve

Resolve the image using the astrometry software and load the solved image in the preview.

You can show the RA/DEC of the cursor by moving the cursor on the image.

If you save the FITS file now it will include the astrometry solution.

Resolve and Slew to image center

Resolve the image using the astrometry software and if the resolution is successful move the telescope at the

position of the image center.

This useful to center the telescope on an image taken on a previous session.

Resolve and Slew to cursor

Resolve the image using the astrometry software and if the resolution is successful move the telescope at the cursor

position.

Can be useful to refine an object position but be careful of the mount backlash.

Resolve and Sync

Resolve the image using the astrometry software and if the resolution is successful Sync the telescope at the

current position.

If you use Eqmod for your telescope driver, this can be used to set the alignment points.

Resolve and show image in planetarium

Resolve the image using the astrometry software and if the resolution is successful view the image in the

planetarium.

Resolve and show CCD frame in planetarium

Resolve the image using the astrometry software and if the resolution is successful center the planetarium at the

position and draw a frame of the CCD field.

View last resolver log

You can take a look at the output log of the astrometry resolver to help to solve a problem or to refine the

performance.

Preview functions

The default display mode for bayer matrix color images is set in the preview preference. You can switch between the

two mode with this menu.
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Preview debayer

Debayer and display the color image if the current image is a raw color image with bayer matrix.

Preview raw

Display the raw image in black/white.
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CCDciel Script

The scripts can be executed from the script tool or part of a sequence.

There is also standard script that are executed on defined occasion:

startup is executed when the program in launched, even before any device is connected. This is the place you

can automatically connect the devices, the autoguider and the planetarium.

shutdown is executed when the program is closed.

end-sequence is executed when a sequence is terminated normally. This is the place you can warmup the ccd

and park the telescope.

unattended_error is executed when a sequence is aborted, you can do the same as in end_sequence and add

more cleanup.

The script language is very powerful and allow for complex tasks.

But this can also be as simple as sending a list of command to different devices.

There is limitations if you use an ARM processor for example with a Raspberry PI device. In this case some function

are not working, specifically the command the require a TStringList.

Script editor

The editor allow to write a script .

The language to use is Pascal Script  [http://en.wikipedia.org/wiki/Pascal_Script], based on Object Pascal

[http://en.wikipedia.org/wiki/Object_Pascal].

Define first the global variables, then the procedure and function if any, then the private variable, and finally the

main code start with begin and end with end.

Read the script example page for a quick start.

The functions specific to the interface with CCDciel are described in a separate script reference page.

Use the Save button to record your change and return to the main window.

The top button are related to the debugging function as describe below.

Script debugger

Simple debugging function are available to test your code.
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To run the script in debug mode press the green arrow Run button. The program is first compiled.

In case of compilation error, the corresponding row is highlighted in yellow, and the error message is show in the

bottom message area.

If the compilation finish without error the program start to run and stop on the first code line of the main

procedure. The current execution position is highlighted in blue.

You can now use the Step over button to execute your program line by line.

The Step into button do the same, except if the current line is a call to one of your function. In this case Step into

allow to run the function line by line, but Step over execute the function and stop at the main program next line.

You can also set a breakpoint on a specific line to jump directly at this position.

To set a breakpoint click on the leftmost column to show a red icon.

Use the Run button to jump to the next breakpoint. The current line is then highlighted in red.

You can remove a breakpoint by clicking on the red icon or all at at time with the Remove all breakpoint button.

You can display the value of variables when the program is in pause at a breakpoint or after a Step over click.

Just click on the variable name anywhere in the program source to display the value in the message area.

Note this work only for local variables, not for object properties.

You can use the Pause button to pause the program execution. This can be useful to examine the condition of an

infinite loop for example.

The Stop button terminate the program execution immediately.
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Script example

This page give tips and example of scripting functions.

You can also look at the template code provided with the program.

For more details about a specific function see the script reference page.

Generality

We first look in detail at the code of the scope_unpark script you can use to unpark the telescope. To open this script

locate the script tool, select “scope_unpark” in the dropdown list and click the Edit button.

This cover many programming basis.

The full script code look as following:

{

  This script unpark the telescope mount

}

 

var ok,parked: boolean;

    arg: TStringList;

    r: string;

begin

 

  // telescope connected?

  GetB('TELESCOPE_CONNECTED',ok);

  if not ok then begin

    logMsg('Telescope not connected!');

    exit;

  end;

 

  // get park status

  GetB('TELESCOPE_PARKED',parked);

 

  if parked then begin

    getSl('STRL1',arg);

    arg.clear;

    arg.add('OFF');

    r:=cmdArg('TELESCOPE_PARK',arg);

    if r<>msgOK then logMsg('Telescope park: '+r);

  end

  else begin

    logMsg('Telescope already unparked');

  end;

end.                                            

Take a look at each part in detail:

{

  This script unpark the telescope mount

}

Is a comment, you can use // {..} (*..*) to enclose your comments.

var ok,parked: boolean;

    arg: TStringList;

    r: string;

Define the variable we use later in the script.

Important variable type are: integer, double, string, boolean.

The Tstringlist type is use here to send a command argument to CCDciel.

  begin

The start of our script.

GetB('TELESCOPE_CONNECTED',ok);

We ask CCDciel about the status of a boolean variable to know if the telescope is connected, the result is in our

variable ok.

  if not ok then begin

    logMsg('Telescope not connected!');

    exit;

  end;

We test the result of the previous command, ok is true if the telescope is connected, so we add the negation “not” to

test for “not connected”. If the result of the test “not connected” is true we execute the code block starting at

“begin” up to the corresponding “end”, this write a message in the log and exit the script.
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GetB('TELESCOPE_PARKED',parked);

We continue and we do the same to check if the telescope is parked, with the result in our parked variable..

    if parked then begin

We test if the telescope is parked, in this case we can unpark.

GetSL('STRL1',arg);

arg.clear;

Request a TStringList object identified by STRL1. We clear any data that may stay in the object. We need this

TStringlist to pass argument to a CCDciel command.

    arg.add('OFF');

    r:=cmdArg('TELESCOPE_PARK',arg);

Add the argument 'OFF' for the command and execute 'TELESCOPE_PARK' 'OFF'. This effectively unpark the

telescope and the result is in variable r.

if r<>msgOK then logMsg('Telescope park: '+r);

We test the result is different than msgOK, in this case we write a message to the log to show the error from the

driver.

 end.

The end of the script.

Open a document

The following code open an html page in the default web browser.

You can use any document type with this function, the document open with the default application the same way as

if you double click the document in the file explorer.

begin

  OpenFile('document.html');

end.

Run a command

There is three different way to run an external command or program, depending if you want to wait for a result or

the command completion or not.

No wait

If the command can run for an undetermined time or do not produce an output you need to use the following form.

This example run the Skychart program and exit immediately without waiting you exit Skychart.

begin

  Run('skychart');

end.

Wait until the end of the command

If you need to wait the end of a command but it only produce an exit code to signal success or failure you can use

the following form.

begin

  if runWait('/bin/bash -c open_dome.sh') then

    logmsg('Dome opened')

  else

    logmsg('Fail to open the dome')  

end.

Wait for a result

The following command run the DIR command in the current directory. The result is stored in a stringlist and the

first entry is show in the log.

var r:TstringList;

begin

  GetSL('STRL1',r);

  r.clear;

  RunOutput('dir',r);

  logmsg(r[0]);

end.
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Script reference

This page contain reference material for scripting functions.

See the script description page for general information.

See the script example page for a quick start with the programming functions.

Script language

The language to use is Pascal Script  [http://en.wikipedia.org/wiki/Pascal_Script].

For a complete reference of the Object Pascal language your can read the Free Pascal Reference guide

[http://www.freepascal.org/docs-html/ref/ref.html]. But beware that some feature are not implemented by the script

language, for example: no pointer, no assembler, no overloading.

In addition to the standard Pascal Script feature the following CCDciel specific function are added.

Constants

name value

deg2rad degree to radian conversion constant

rad2deg radian to degree conversion constant

msgOK returned when a CCDciel command complete successfully

msgFailed returned when a CCDciel command fail

Global variables access

function GetS(varname:string; var str: string):Boolean;

Get the global string variable identified by varname

varname value

LASTERROR The text of the last error

Str1 .. Str10 Ten global variable for your use

function SetS(varname:string; str: string):Boolean;

Set the global string variable identified by varname for later use

varname value

Str1 .. Str10 Ten global variable for your use

function GetSL(varname:string; var strl: Tstringlist):Boolean;

Get the global stringlist variable identified by varname

varname value

Strl1 .. Strl10 Ten global variable for your use

function SetSL(varname:string; stlr: Tstringlist):Boolean;

Set the global stringlist variable identified by varname for later use

varname value

Strl1 .. Strl10 Ten global variable for your use

function GetI(varname:string; var i: Integer):Boolean;

Get the global integer variable identified by varname
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varname value

Int1 .. Int10 Ten global variable for your use

function SetI(varname:string; i: Integer):Boolean;

Set the global integer variable identified by varname for later use

varname value

Int1 .. Int10 Ten global variable for your use

function GetD(varname:string; var x: double):boolean;

Get the global double variable identified by varname

varname value

TelescopeRA The telescope position right ascension

TelescopeDE The telescope position declination

TimeNow The current time in TDateTime format

CCDTEMP The current CCD temperature

Double1 .. Double10 Ten global variable for your use

function SetD(varname:string; x: Double):Boolean;

Set the global double variable identified by varname for later use

varname value

Double1 .. Double10 Ten global variable for your use

function GetB(varname:string; var x: boolean):boolean;

Get the global boolean variable identified by varname

varname value

TELESCOPE_CONNECTED True if the telescope is connected

TELESCOPE_PARKED True if the telescope is parked

TELESCOPE_EQMOD True if the telescope use the EqMod driver

AUTOGUIDER_CONNECTED True if the auto-guider is connected

AUTOGUIDER_RUNNING True if the auto-guider is running

AUTOGUIDER_GUIDING True if the auto-guider is guiding

WHEEL_CONNECTED True if the filter wheel is connected

FOCUSER_CONNECTED True if the focuser is connected

CAMERA_CONNECTED True if the camera is connected

PLANETARIUM_CONNECTED True if the planetarium is connected

PREVIEW_RUNNING True if the preview is running

PREVIEW_LOOP True if the preview is in loop

CAPTURE_RUNNING True if a capture is running

Commands

function Cmd(cname:string):string;

Execute a simple command cname in CCDciel.

Valid Cmd() command are:

Command Description
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TELESCOPE_ABORTMOTION Stop any telescope movement

TELESCOPE_TRACK Start telescope tracking

EQMOD_CLEARPOINTS Clear EqMod alignment data

EQMOD_CLEARSYNCDELTA Clear Eqmod sync delta

EQMOD_STDSYNC Set Eqmod in Standard sync mode

EQMOD_APPENDSYNC Set Eqmod in Add point on sync mode

AUTOGUIDER_CONNECT Connect to the autoguider software

AUTOGUIDER_CALIBRATE Force a new calibration of the autoguider

AUTOGUIDER_STARTGUIDING Start to guide

AUTOGUIDER_STOPGUIDING Stop guiding

AUTOGUIDER_PAUSE Pause guiding

AUTOGUIDER_UNPAUSE Restart after pause

AUTOGUIDER_DITHER Dither now

AUTOGUIDER_SHUTDOWN Close the autoguider program

WHEEL_GETFILTER Get the current filter number in the wheel

PREVIEW_SINGLE Start a single preview

PREVIEW_LOOP Start a preview loop

PREVIEW_WAITLOOP Wait until the user stop the preview loop

PREVIEW_STOP Stop any in progress preview or preview loop

CAPTURE_START Start a capture

CAPTURE_STOP Stop a capture

ASTROMETRY_SOLVE Plate solve the current image

ASTROMETRY_SYNC Plate solve the current image and sync the telescope

ASTROMETRY_SLEW_IMAGE_CENTER Plate solve the current image and slew the telescope

PLANETARIUM_CONNECT Connect the planetarium software

PLANETARIUM_SHOWIMAGE Plate solve the current image and show in planetarium

PLANETARIUM_SHUTDOWN Close the planetarium software

PROGRAM_SHUTDOWN Close CCDciel

CLEAR_REFERENCE_IMAGE Remove the reference image

AUTOFOCUS Run auto-focus at the current position

AUTOMATICAUTOFOCUS Move to a bright star and run auto-focus, return to last position when

finished

function CmdArg(cname:string; arg:Tstringlist):string;

Execute a command cname in CCDciel with parameters arg. Add each parameter to the string list.

Valid CmdArg() command are:

Command Arguments Description

DEVICES_CONNECTION ON/OFF Connect or disconnect the devices

TELESCOPE_SLEW RA, DEC Slew to specified coordinates

TELESCOPE_SYNC RA, DEC Sync to specified coordinates

TELESCOPE_PARK ON/OFF Park or unpark the telescope

WHEEL_SETFILTER number Set the filter number in the wheel

WHEEL_GETFILTERSNAME arg On return arg contain the name of the filters

WHEEL_SETFILTERSNAME arg Put each filter name in arg

CCD_SETTEMPERATURE temp Set the CCD temperature

PREVIEW_SETEXPOSURE exp Set the preview exposure time

PREVIEW_SETBINNING bin Set the preview binning
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CAPTURE_SETEXPOSURE exp Set the capture exposure

CAPTURE_SETBINNING bin Set the capture binning

CAPTURE_SETOBJECTNAME name Set the capture object name

CAPTURE_SETCOUNT count Set the capture image count

CAPTURE_SETFRAMETYPE Light/Bias/Dark/Flat Set the capture frame type

CAPTURE_SETDITHER count Set the capture Dither count

SEQUENCE_START sequence Load and start the sequence

SAVE_FITS_FILE filename Save the FITS file

OPEN_FITS_FILE filename Open the FITS file

OPEN_REFERENCE_IMAGE filename Load a reference image

Delay functions

procedure Wait(wt:integer);

Wait wt seconds before to continue the execution

function WaitTill(hour:string; showdialog: boolean):boolean;

Wait until the time is “hour”, encoded as 23:30:00 .

If the time is already passed by less than 12h the function return immediately, if it is passed for more than 12h it

wait for the next day.

If showdialog is true a dialog with time countdown is show, this dialog also allow to cancel or to continue

immediately, it return False if the wait is canceled.

Coordinates conversion

Procedure Eq2Hz(var ra,de : double ; var a,h : double);

Convert Equatorial ra,de to Alt/Az a,h for the location and time of the current chart, all angle in radian

Procedure Hz2Eq(var a,h : double; var ra,de : double);

Convert Alt/Az a,h to equatorial ra,de for the location and time of the current chart, all angle in radian

Formating and conversion

Function ARtoStr(var ar: Double) : string;

Return a string formated Right Ascension of ar value

Function DEtoStr(var de: Double) : string;

Return a string formated Declination of de value

Function StrtoAR(str:string; var ar: Double) : boolean;

Convert a formated string to Right Ascension decimal value

Function StrtoDE(str:string; var de: Double) : boolean;

Convert a formated string to Declination decimal value

Function JDtoStr(var jd: Double) : string;
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Format a julian date to YYYY-MM-DD string

Function StrtoJD(dt:string; var jdt: Double) : boolean;

Convert a formated string YYYY-MM-DD to julian date value

Function FormatFloat(Const Format : String; var Value : double) : String;

Format a decimal number according to the Format  [http://www.freepascal.org/docs-html/rtl/sysutils/formatfloat.html]

specification

Function Format(Const Fmt : String; const Args : Array of const) : String;

The Format  [http://www.freepascal.org/docs-html/rtl/sysutils/format.html] Pascal function

Procedure StrtoFloatD(str:string; var defval: Double; var val: Double);

Convert a string to a floating point value. Return defval if the string is a invalid number

function IsNumber(str: String): boolean;

Return True if the string represent a valid number

function StringReplace(str,s1,s2: String): string;

Replace all occurrence of s1 by s2 in str

Dialog

function MsgBox(const aMsg: string):boolean;

A message confirmation dialog. Return True if YES is clicked.

Procedure ShowMessage(const aMsg: string);

Display a message.

Procedure LogMsg(const aMsg: string);

Write a message to the log

Run external program

function Run(cmdline:string):boolean;

Execute the specified command. Return immediately without waiting for the execution to end.

function RunWait(cmdline:string):boolean;

Execute the specified command. Wait for termination.

function RunOutput(cmdline:string; var output:TStringlist):boolean;

Execute the specified command, wait for termination and put the stdout to “output”. Beware this function can
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completely lock the main program if it not finish in time.

function OpenFile(fn:string):boolean;

Open a document file using the default program
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Installation on Ubuntu, Debian

Bellow installation procedure uses only command line approach, because this is the simpler way to follow

instructions just by copy-pasting the commands in terminal.

This same procedure can be used with any system using deb packages (Debian, Mint, Raspbian, …)

CCDciel and it's dependency are available from the same repository as Skychart  [https://www.ap-i.net/skychart], but you

need the unstable repository as long this program is in beta version only.

1. Add Skychart unstable repository:

sudo apt-add-repository 'deb http://www.ap-i.net/apt unstable main'

2. Install the public key:

apt-key adv --keyserver keyserver.ubuntu.com --recv-keys AA716FC2

3. Update repository:

sudo apt-get update

4. Install CCDciel:

sudo apt-get install ccdciel

See also the list of the optional dependencies to install to take full advantage of the software.
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Installation on Linux

If your Linux system use deb packages,see Installation on Ubuntu.

For other Linux system you can download rpm or tar packages from the Sourceforge download

[http://sourceforge.net/projects/ccdciel/files/] link.

The requirement are Gtk2 and libpasastro [https://sourceforge.net/projects/libpasastro/].

See also the list of dependencies to install to take full advantage of the software.

You can also compile the source code [https://sourceforge.net/p/ccdciel/code/] using Lazarus [http://www.lazarus-

ide.org/index.php].
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Installation on Windows

CCDciel can run on any version of Windows from XP to 10.

To use the devices connected to your Windows computer you need the ASCOM platform  [http://ascom-standards.org/]

and the drivers for you hardware.

But you can also use the devices connected to a remote Linux system (Raspberry PI for example) using the INDI

protocol.

You can download the setup installer from the Sourceforge download [http://sourceforge.net/projects/ccdciel/files/] link.

See also the list of the optional dependencies to install to take full advantage of the software.
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Installation on Mac OS X

CCDciel can run on a recent version of Mac OS X on a computer with an Intel processor.

To use the devices connected to your Mac computer you need the INDI [http://www.indilib.org/] library and the drivers

for you hardware, available from CloudMakers [http://www.cloudmakers.eu/xindi/].

You can download the dmg installer from the Sourceforge download [http://sourceforge.net/projects/ccdciel/files/] link.

See also the list of the optional dependencies to install to take full advantage of the software.
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ASCOM

ASCOM [http://ascom-standards.org] Platform is the standard astronomical equipment driver for Windows.

Install the ASCOM platform and the drivers you need from http://ascom-standards.org/Downloads/Index.htm

[http://ascom-standards.org/Downloads/Index.htm] or from your equipment manufacturer.
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INDI

INDI [http://www.indilib.org/] Library is the standard astronomical equipment  [http://www.indilib.org/devices/] driver for

Linux and Mac OS X.

You can install INDI with the packages provided by your Linux distribution, but as this is a rapidly moving project it is

best to get the latest version [http://www.indilib.org/download.html] directly from the project.

For example for Debian/Ubuntu see https://launchpad.net/~mutlaqja/+archive/ubuntu/ppa

[https://launchpad.net/~mutlaqja/+archive/ubuntu/ppa]

For Mac OS X the best option is to get the version from CloudMakers [http://www.cloudmakers.eu/xindi/].

There is no INDI server for Windows but you can run CCDciel on Windows to connect to a remote Linux computer. Or

use wINDI [http://www.cloudmakers.eu/windi/] to use your ASCOM devices with the INDI protocol.
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Astrometry.net

Astrometry.net can be used to solve the image you just take with your camera.

CCDciel need a local copy of the Astrometry.net software and the required indexes on your computer. It can also use

the web version using the provided script.

Look at this page http://astrometry.net/use.html [http://astrometry.net/use.html] for instruction to install the software

and the data.

Linux

On Linux astrometry.net is probably packaged by your distribution. This is the easiest and preferred way to install

the software.

For example on Debian or Ubuntu just do:

 sudo apt-get install astrometry.net

Mac OS X

For Mac OS X the best option is to get the version from CloudMakers [http://www.cloudmakers.eu/xindi/].

Windows

A number of Windows package include a fully automated install of Cygwin and astrometry.net and it is best to get

one of them. CCDciel do not use this applications but the astrometry.net they install.

The following list indicate tested application and give the Cygwin path you must configure in the astrometry

preferences.

At the time of writing all this application use the same version 0.38 of astrometry.net.

Astrotortilla [https://sourceforge.net/projects/astrotortilla/], set Cygwin path to C:\cygwin

ANSVR [https://adgsoftware.com/ansvr/], set Cygwin path to C:\Users\[your user name]\AppData\Local\cygwin_ansvr

All sky plate solver [http://www.astrogb.com/astrogb/All_Sky_Plate_Solver.html], set Cygwin path to C:\Users\[your user

name]\AppData\Local\Astrometry
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ELBRUS

Elbrus star locator can be used to solve the image you just take with your camera.

Look at the program page for instruction http://www.astrosurf.com/pulgar/elbrus/elbrusin.htm

[http://www.astrosurf.com/pulgar/elbrus/elbrusin.htm]

Before you can use it the Elbrus program must be calibrated for your images. Then select File / E-Wait for message.

Also be sure to set the parameter: “Add the WCS in the FITS header”.

This is a Windows only software but I find it easy to install and use on Linux with Wine.

On the astrometry preference you can set both the DOS and Unix path to the image data to help with this use.

To install Wine on Linux or Mac OS X see Wine web pages [https://www.winehq.org/].

On Linux the best way is to install the wine packages provided by your distribution.
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